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Preface

Preface

Welcome to the Trend Micro™ SafeSync for Enterprise™ Installation Guide. This
document discusses requirements and procedures for installing SafeSync, verifying the
installation, and performing post-installation tasks.

Topics in this chapter include:
. SafeSync Documentation on page vi
Audience on page vii

«  Document Conventions on page vii

o Terminology on page viii
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SafeSync Documentation

SafeSync documentation includes the following,

TABLE 1. SafeSync Documentation

DOCUMENTATION

DESCRIPTION

Installation Guide

A PDF document that discusses requirements and procedures for
installing SafeSync.

Administrator's

A PDF document that provides "how to's", advice, usage and

Guide field-specific information.

Quick Start Guide The Quick Start Guide provides user-friendly instructions on
connecting SafeSync to your network and on performing the
initial configuration.

Help HTML files compiled in WebHelp or CHM format that provide
"how to's", usage advice, and field-specific information. The Help
is accessible from the SafeSync web console.

Readme file Text-based documentation that contains late-breaking product

information that might not be found in the other documentation.
Topics include a description of features, installation tips, known
issues, and product release history.

Knowledge Base

An online database of problem-solving and troubleshooting
information. It provides the latest information about known
product issues. To access the Knowledge Base, go to the
following website:

http://esupport.trendmicro.com

Download the latest version of the PDF documents and readme at:

http://docs.trendmicro.com/en-us/enterprise/safesync-for-enterprise.aspx



http://esupport.trendmicro.com
http://docs.trendmicro.com/en-us/enterprise/safesync-for-enterprise.aspx

Preface

Audience

SafeSync documentation is intended for administrators responsible for installing and
managing SafeSync. These administrators are expected to have advanced networking and
server management knowledge.

Document Conventions

The documentation uses the following conventions.

TABLE 2. Document Conventions

CONVENTION DESCRIPTION
UPPER CASE Acronyms, abbreviations, and names of certain
commands and keys on the keyboard
Bold Menus and menu commands, command buttons, tabs,
and options
Italics References to other documents
Monospace Sample command lines, program code, web URLs, file

names, and program output

Navigation > Path The navigation path to reach a particular screen

For example, File > Save means, click File and then click
Save on the interface

Configuration notes

ﬁ’ Note

Q Tip Recommendations or suggestions

— Information regarding required or default configuration
Important . L
Q settings and product limitations
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CONVENTION DESCRIPTION

ﬁ WARNING!

Critical actions and configuration options

Terminology

The following table provides the official terminology used throughout the SafeSync
documentation.

TABLE 3. SafeSync Terminology

TERMINOLOGY DESCRIPTION

Administrator (or SafeSync | The person managing the SafeSync server
administrator)

Console The user interface for configuring and managing
SafeSync
The console for the SafeSync server program is called
"web console".

End user Users that share content using SafeSync

Portal The end-user web console for managing SafeSync files




Chapter 1

Introducing SafeSync

This chapter introduces SafeSync and provides an overview of its features and benefits.
Topics in this chapter include:
o About SafeSync on page 1-2

What's New on page 1-2

«  Features and Benefits on page 1-5




SafeSync for Enterprise Installation Guide

About SafeSync

Trend Micro™ SafeSync for Enterprise™ allows enterprises to securely synchronize,
share, and manage corporate data. Deployed on premise and in a private cloud, SafeSync
provides file encryption and document tagging to prevent unauthorized access to
sensitive data. SafeSync also supports file version control and redundant file backup.

Businesses benefit from reduced infrastructure resource usage by using file sharing links
instead of sending files through email servers. The web-based administrator console
makes it easy to manage users, set coordinated policies and plans, and review logs and
reports. SafeSync provides administrators the visibility required to control data misuse,
compliance violations, and security risks.

What's New

What's New in This Version

The following new features and enhancements are available in version 2.1 SP1.
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TABLE 1-1. New Features and Enhancements for SafeSync for Enterprise 2.1 SP1

FEATURE DESCRIPTION

Antivirus scan Perform Antivirus scan when users upload
or share files.

After installing this service pack, SafeSync
for Enterprise can perform antivirus scan
on files and quarantine files detected as
malicious. SafeSync for Enterprise
provides a configurable secure
environment for data uploading, sharing,
downloading, and synchronization.

Prevent malicious files from spreading.

Files detected as malicious are
quarantined to prevent users from
accidentally opening the files. The detected
files are not synchronized, downloaded, or
shared.

Analyze threat detection trends at a
glance.

Administrators can easily manage the
threat status using widgets. Threat
detection widgets include threat statistics,
top 10 detection and top 10 threats, and
component status. Administrators have the
option of exporting the data into CSV files.

Specify Active Update and Smart
Protection Server sources.

Administrators can specify the Active
Update and Smart Protection Server
sources based on the network
environment.

Multiple downloads End users can download multiple files and
folders as an archived file from the end-
user portal.




SafeSync for Enterprise Installation Guide

FEATURE DESCRIPTION

More platform support SafeSync for Enterprise Windows client
support for Windows 8.1.

Active Directory integration now supports
the Windows 2012 Active Directory server.

What's New in Version 2.1

The following new features and enhancements are available in version 2.1.

TABLE 1-2. New Features and Enhancements for SafeSync for Enterprise 2.1

FEATURE DESCRIPTION

Active Directory integration - Enhanced Active Directory integration

«  Select and assign Active Directory
users and groups permission to use
the SafeSync service from the
SafeSync web console

Shared Protection Extension add-in +  File encryption
Secure file sharing

Encrypt files under a folder
automatically

Outlook Extension add-in Enhanced with the Shared Protection
Extension features

Dashboard widget System Status Alert widget

Policy management Control how end users share and upload
files

Plan management Assign plans to domain users based on

plan priority or specify plans
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FEATURE DESCRIPTION

Logs

Log query
Log maintenance

Syslog server settings

Administration

System updates

License management for SafeSync
add-ins

End user mobile

apps User interface enhancements

Features and Benefits

SafeSync provides the following:

BENEFIT

DESCRIPTION

Access files from
anywhere

Anytime, anywhere file accessing, editing, and organizing
from any device: PCs, Macs, and Android and iOS mobile
devices.

Sync files continuously | Data storage and synchronization with additional file copies
and automatically held on your on-premise servers that can be easily restored or

accessed, in case of a hardware loss, theft, or failure.

Data storage and synchronization with additional file copies
held on Trend Micro cloud servers.

Continuous automatic file synchronization with 2 ways to
synchronize files. End users can drag and drop files easily
into the folder they wish to sync.

Folder pairing enables automatic syncing of an entire folder
without the need to drag and drop files into the SafeSync
folder.
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BENEFIT

DESCRIPTION

Share files easily and
securely

Fast and secure file and folder sharing with the shareable link.

Set links with passwords that expire for additional security.

“Team Folders” for effective group collaboration that can be
created on the fly by staff and administrators.

Easily create and
control user accounts

SafeSync supports centralized administration for creating and
controlling users.

Recover previous
versions of files

Recover deleted files or previous file versions from the end
user portal.

Protect files with
encryption

Protect files with the same Advanced Encryption Standard
(AES) 256-bit encryption used by the government and military.

Securely share email
attachments sent from
Microsoft Outlook

When the SafeSync Outlook Extension is enabled, users
can either upload their attachments to SafeSync and send a
shareable link in the email, or use the auto-encryption option
to automatically encrypt file attachments.

When the auto-encryption option is enabled, all attachments
are automatically encrypted and the only people who can
open the attachments are the SafeSync users who are the
original recipients of the email.

The SafeSync Outlook Extension helps to prevent
unintentional data leakage through misdirected or forwarded
emails, or device loss.

Automatically encrypt
files using an auto-
encryption folder

When the Shared Protection Extension is enabled, users
can create an auto-encryption folder. All files added to this
folder are encrypted automatically.

When a user creates an auto-encryption folder, they are
prompted to identify who can access the folder. An auto-
encryption folder is essentially an encrypted team folder.

Use the auto-encryption folder to securely share sensitive
files, such as those used by Human Resources or Finance.

Convenient remote
administration

You have the ability to control user accounts and share or
revoke access to your shared files at any time.
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BENEFIT DESCRIPTION

Prevent data loss Create policies to block specific file types and prevent the
transmission of digital assets against accidental or deliberate
leakage through the use of file encryption settings.

Scan files for virus/ When the antivirus feature is enabled, SafeSync automatically
malware threats scans uploaded and shared files for virus/malware threats.
After detecting a potentially malicious file, SafeSync warns
users before downloading the file.







Preparing for Installation

This chapter explains how to plan and prepare for a SafeSync installation.

Topics in this chapter include:

System Requirements on page 2-2
Registration Key and Activation Codes on page 2-2

Fresh Installation Considerations on page 2-3

Basic Installer Operations on page 2-13
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System Requirements

The following table provides the system requirements for using SafeSync.

TABLE 2-1. System Requirements

HARDWARE/SOFTWARE DESCRIPTION
Network switch 1GB
CPU 64-bit x86 (dual-core recommended)
Memory 8 GB (32 GB recommended)
Network card Two NICs (1 GB recommended)
System disk space 60 GB (for SafeSync installation)
Storage disk space The disk storage size is dependent on user

requirements.

Tip

Trend Micro recommends allocating 8 to 10 GB
for each user. If you want to replicate all of the
users'’ files, the allocated space is doubled (16 to
20 GB). For example, if you intend to have 100
users, the recommended storage space is 2TB.

Virtual machine « VMware ESXi™ 4 .x, 5.x

- VMware® WorkStation™ 6.x, 7.x or above
«  Oracle VM VirtualBox™ 4.2.x

«  Microsoft Hyper-V™ 6.2.9200.16384

Registration Key and Activation Codes

During installation, specify the Activation Codes for the following:

. SafeSync
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. Outlook Extension (optional)
. Shared Protection Extension (optional)

Use the Registration Key that came with the product to obtain Activation Codes (if not
already obtained). Setup automatically redirects to the Trend Micro website for product
registration.

http://olr.trendmicro.com
After registering the product, Trend Micro sends the Activation Codes.

Contact a Trend Micro sales representative to obtain the Registration Key or Activation
Codes, if neither is available at the time of installation. For more information, see
Contacting Trend Micro on page 8-2.

ﬁ Note

For questions about registration, refer to:

ort/viewxml.do?ContentID=en-116326.

Fresh Installation Considerations

Consider the following when performing a fresh installation of the SafeSync server:
*  Required Network Settings on page 2-4

« High Availability on page 2-7

« Network Interface Cards on page 2-10

« Ports Used by SafeSync on page 2-11

Servers

SafeSync uses the following servers.



http://olr.trendmicro.com
http://esupport.trendmicro.com/support/viewxml.do?ContentID=en-116326
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TABLE 2-2. SafeSync Servers

SERVER

DESCRIPTION

SafeSync

Storage space for installing SafeSync

You can choose to install SafeSync on a bare metal server or a
virtual machine.

For more information, see Installing SafeSync on page 3-1 and
Installing on Virtual Machines on page 4-1.

Domain Name
System (DNS)

Server for storing the DNS records or network settings used by
SafeSync

For more information, see Required Network Settings on page
2-4.

SMTP Email server for sending system notifications
Configure the SMTP server and system notification settings from
the SafeSync administrator console.
For more information, see the SafeSync Administrator's Guide.
Proxy Server that acts as an intermediary between the SafeSync server

or clients and the Internet

If the network requires that SafeSync uses a proxy server,
configure the proxy server from the administrator console.

For more information, see the SafeSync Administrator's Guide.

Required Network Settings

SafeSync requires the following network settings.

TABLE 2-3. Required Network Settings

DNS RECORD DESCRIPTION

<subdomain>.<your_domain>.com Used for domain mapping

www.<subdomain>.<your_domain>.com Used for accessing services




Preparing for Installation

DNS RECORD DESCRIPTION

soap.<subdomain>.<your_domain>.com Used for connections between SafeSync
server and clients

dav.<subdomain>.<your_domain>.com Used for connections between SafeSync
server and clients

Important

SafeSync requires a fully qualifiied domain name (FQDN).

For example, if your domain is company and your subdomain is safesync, you will need
the following network settings.

. safesync.company.com

. www.safesync.company.com
. soap.safesync.company.com
. dav.safesync.company.com

ﬁ Note

If the network settings are incorrect, the following error message appears when logging on
to the end-user portal: The connection has timed out.

Single-Server Deployment

SafeSync requires the following DNS settings for a single-server deployment.

TABLE 2-4. Required DNS Settings for Single-Server Deployment

FQDN TYPE DATA

<subdomain>.<your_domain>.com Sub-domain | Primary Server IP

For example, 10.20.30.234

2-5
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FQDN TYPE DATA

www.<subdomain>.<your_domain>.com Host (A) Primary Server IP

For example, 10.20.30.234

soap.<subdomain>.<your_domain>.com Host (A) Primary Server IP

For example, 10.20.30.234

dav.<subdomain>.<your_domain>.com Host (A) Primary Server IP

For example, 10.20.30.234

High Availability Deployment
SafeSync requires the following DNS settings for a high availability deployment.

TABLE 2-5. Required DNS Settings for High Availability Deployment

FQDN TYPE DATA

<subdomain>.<your_domain>.com Sub-domain | Primary Server IP

For example, 10.20.30.234

www.<subdomain>.<your_domain>.com Host (A) Primary Server IP

For example, 10.20.30.234

soap.<subdomain>.<your_domain>.com Host (A) Primary Server IP

For example, 10.20.30.234

dav.<subdomain>.<your_domain>.com Host (A) Primary Server IP

For example, 10.20.30.234

www.<subdomain>.<your_domain>.com Host (A) Secondary Server IP

For example, 10.20.30.235

soap.<subdomain>.<your_domain>.com Host (A) Secondary Server IP

For example, 10.20.30.235
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FQDN TYPE DATA

dav.<subdomain>.<your_domain>.com Host (A) Secondary Server IP

For example, 10.20.30.235

High Availability

The high availability (HA) feature of SafeSync requires two appliances to avoid having a
single point of failure. The secondary server acts as a backup and failover for increased
reliability. High availability deployments help reduce system downtime and data loss.

In a high availability deployment, the second network interface card (NIC) of the
primary server must be connected to the second NIC of the secondary server using a
network switch. Use a standalone switch for bare metal server installations and a virtual
switch for virtual machine installations.

TABLE 2-6. Primary and Secondary Servers

SERVER DESCRIPTION

Primary server +  Always installed first

Configuration and testing of the primary server must be
completed before setting up the secondary server

Secondary server - Installed after configuring and verifying the primary server
Does not need to be configured

Primary server settings are replicated during the installation
of the secondary server
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Primary Server

| ' i
FrontendO @
Intranet/Internet
Server
DatabaseO ‘ @ .
Y J Standalone Switch

Secondary Server

| i i
FrontendO
Server
DatabaseO
A

FIGURE 2-1. High Availability Deployment on Bare Metal Servers

You may use either file replication or load balancing to achieve high availability in
SafeSync.

For more informaion, see File Replication on page 2-9 and 1oad Balancing on page 2-9.
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File Replication

SafeSync leverages existing MySQL Master-Master Replication to achieve file replication
high availability. The MySQL Master-Master Replication means that both primary and
secondaty servers function as a Master MySQL server. Any SQL statement executed in
one server is pulled and executed on the other server. From an application point of view,
both servers’ databases are fully replicated.

The default file replication number is 2. This means that all files uploaded by users are
stored on both servers. File replication has two main benefits:

+  Prevents having a single point of failure by using two servers
+  Increases service performance by providing access to two different physical
locations

SafeSync automatically generates streaming and thumbnail files when users upload
certain file types. The auto-generated files’ replication number is 1.

ﬁ Note

Storage space is used by balanced percentages. This means newly added storage is used
first.

Load Balancing

There are two ways to achieve load balancing high availability. The first method uses a
Network Load Balancer (NLB). The second method implements a Domain Name
System (DNS) load balance.

The NLB requites third-party hardwate and/or software and the configuration will
depend on the type of NLB used. The required DNS records for SafeSync needs to
point to the NLB's IP address.

DNS load balance means setting up the required DNS records for SafeSync and
pointing them to the production IP address of both the primary and secondary servers.
This means each fully qualified domain name (FQDN) resolves two IP addresses.
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Network Interface Cards

SafeSync requires each server to have two network interface cards (NICs) during
installation. The first NIC must be connected to the Internet and/or Intranet. The
second NIC must be connected to a network switch. Both NICs must be connected to
the right switch during installation.

ﬁ Note

In a high availability deployment, the second NIC of the primary server must be connected
to the second NIC of the secondary server.

For more information, see High Availability on page 2-7.

Roles of the Network Interface Cards

SafeSync requires two network interface cards (NICs) for each server. The first NIC is
labeled as frontend0 and the second NIC is labeled as database0.

The following table describes the roles of the two NICs.

TABLE 2-7. NIC Roles

LABEL DESCRIPTION

frontend0 - Assigned to the first available NIC on the server
«  Should be connected to the Internet and/or Intranet

- The IP addess, subnet, gateway, and DNS server settings
are configured during installation

Settings can be changed from the administrator console after
installation

+  Serves as the data port

Note

It is used for communication with other hosts or
devices, clients, and users in the network.
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LABEL

DESCRIPTION

databaseO

Assigned to the second NIC on the server

Should be connected to a network switch

ﬁ’ Note

In a high availability deployment, the second NIC of the
primary server must be connected to the second NIC
of the secondary server using a network switch. Use a
standalone switch for bare metal server installations
and a virtual switch for virtual machine installations.

The IP address and subnet are automatically assigned during
installation

For appliance1: 192.168.200.1

For appliance2: 192.168.200.2

Tip
Trend Micro recommends reserving the network

segment with an IP range of 192.168.200.x for SafeSync
to avoid conflicts with databaseo0.

The IP address settings for this NIC should not be changed

Serves as the database communication port

Note

It is used for database communication and replication
traffic between the two servers.

Ports Used by SafeSync

The following table shows the ports that are used with SafeSync and why they are used.

211
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PORT PRrROTOCOL FUNCTION PURPOSE

22 TCP Inbound SafeSync uses this port to:

Allow the administrator to gain
remote access to the servers

+  Establish communication
between the primary and
secondary servers

80 TCP Inbound and | SafeSync uses this port to:

Outbound .
«  Connect to the Smart Protection

Network or the local Smart
Protection Server

. Update components by
connecting to the ActiveUpdate
server

- Connect to SafeSync services

443 TCP Inbound and | SafeSync uses this port to:

Outbound .
. Connect to all services

+  Access the administrator console
through HTTPS

Access the end-user portal
through HTTPS

+  Connect to SafeSync clients

3443 TCP Inbound SafeSync uses this port to request
HTTP access to the administrator
console.

ﬁ Note

The administrator console can
be accessed using https://
<SafeSync IP address or FQDN>:3443.
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SSL Certificate

SafeSync requires SSL certificates to enable secure connections between the server and
browsers.

ﬁ Note

The SSL certificate is imported from the SafeSync administrator console.

When importing certificates, the following must be considered:
. Certificates must use the PEM file format.

*  Whenever available, intermediate certificates must be included when importing the
certificate. The typical sequence of the certificate chain is:

Server Certificate > Intermediate Certificate > Root Certificate

+  The certificate chain must be copied into the administrator console all at once and
in the proper sequence.

. Whenever available, Certificate Attributes must be included.

+  Third-party certificates must use the following format:
*.<subdomain>.<your_domain>.com

Basic Installer Operations

Use the following keyboard keys to perform basic operations during the installation
process.

Important

Disable scroll lock (using the Scroll Lock key on the keyboard) to perform the following
operations.
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KEYBOARD KEY OPERATION
Left and Right Move between buttons
arrows )
Buttons are enclosed in angle brackets <>.
Move between characters in a text box
Enter Click the highlighted button
Space bar Select the highlighted item from a choice list




Installing SafeSync

This chapter explains how to install SafeSync on bare metal servers.
Topics in this chapter include:

*  nstalling a SafeSync Appliance on page 3-2

Installing SafeSync Appliances for a High Availability Deployment on page 3-8
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Installing a SafeSync Appliance

Install SafeSync on a bare metal server. The following procedure explains the required
steps when installing a single server or when installing the first server in a high
availability deployment.

ﬁ WARNING!

Any existing data or partitions are removed during the installation process. Back up any

existing data on the server before installing SafeSync.

Procedure

1.  On a bare metal server, insert the installation DVD into the DVD drive.

2. Power on the bare metal server.
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A prompt appears with information about installing SafeSync.

FIGURE 3-1. SafeSync for Enterprise Installation screen

3. Select OK.

The Select Installation Type screen appeats.

(><)@Primary server

FIGURE 3-2. Select Installation Type screen
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4.  Select Primary server to install a single server or to install the first server in a high
availability deployment.

5.  Select Next.

The Web Console Account screen displays.

< Next >

FIGURE 3-3. Web Console Account screen

6. Type a password for the web console account.

Note
-

The web console account password is used to log on to the administrator web
console.

7. Select Next.

The Confirm Password screen displays.

< Next >

FIGURE 3-4. Confirm Password screen
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8.  Retype the password and select Next.

The System Account screen displays.

FIGURE 3-5. System Account screen

9. Type a password for the server system account.

Note

The system account password is used to log on to the command line console of the
SafeSync server.

10. Select Next.

The Confirm Password screen displays.

11.  Retype the password and select Next.
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The Configure Network (1/2) screen displays.

nmt

(>)B=thO Intel Corporation 82545EM Gigabit Ethernet Controller (Copper
't 6 o 1] ISEM Gigabit Ethernet Controller ¢

nte DO

FIGURE 3-6. Configure Network (1/2) screen
12. Select a network interface card for NIC1 (frontendO).

The Configure Netwotrk (2/2) screen displays.

(>)Bethl Intel Corporation 82545EM Gigabit Ethernet Controller (Copper

FIGURE 3-7. Configure Network (2/2) screen
13. Select a network interface card for NIC2 (database0).

14. Select Next.
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The Web Console Settings screen displays.

FIGURE 3-8. Web Console Settings screen

15.  Select one of the following to determine the connection settings for the end-user
portal and the administrator web console:

+  Select Yes to use the default connection settings.

+  Select No to modify the connection settings.

Note

If you choose to modify the default values, you must type the new connection
settings before you can proceed with the installation process.

The installation process begins. An Ubuntu® Linux operating system is first
installed on the server, and then SafeSync is installed.

Note
.

Depending on your environment, installation can take as long as 30 minutes up to
one hour.
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Once installation completes, the Log On screen for the command line console
appears.

onfiguration completed!?
ress <Enter> to continue.

se the following URL and account information to access the SafeSync
anagement console.

anagement console:

eb console account: administrator
2 HHH K

, use the following account information to log
on to Ubuntu:

ystem account: safesync
[

OTE: Trend Micro recommends changing the default user name and password as soon
as you complete the SafeSync installation.

ppliancel login:

FIGURE 3-9. Configuration Completed screen

16. Using a web browser, log on to the administrator web console (https://<SafeSync
domain name>:3443) using the previously specified password.

Installing SafeSync Appliances for a High
Availability Deployment

Install a secondary server to enable the high availability feature of SafeSync.

WARNING!

Any existing data or partitions are removed during the installation process. Back up any
existing data on the server before installing SafeSync.
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Procedure

1.  On a bare metal server, insert the installation DVD into the DVD drive of the
secondary server.

Note

Make sure that the primary server is working before installing the secondary server.
You cannot install a secondary server if the primary server is not yet installed.

2. Power on the bare metal server.

A prompt appears with information about installing SafeSync.

FIGURE 3-10. SafeSync for Enterprise Installation screen

3. Select OK.
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The Select Installation Type screen appears.

BCD“C]GI‘U ISErVEYr

< Next >

FIGURE 3-11. Select Installation Type screen

4.  Sclect Secondary server to install the second server in a high availability
deployment.

Note

Press the space bar to select the secondary server.

For more information, see Basic Installer Operations on page 2-13.

The Install Secondary Server screen displays.

< Next >

FIGURE 3-12. Install Secondary Server screen

5.  Select Next.
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The System Account screen displays.

FIGURE 3-13. System Account screen

6. Type a password for the secondary server system account.

Note
E

The system account password is used to log on to the command line console of the
secondary SafeSync server.

7.  Select Next.

The Confirm Password screen displays.

8.  Retype the password and select Next.
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The Configure Network (1/2) screen displays.

(>)B=thO Intel Corporation 82545EM Gigabit Ethernet
Intel Corporation 5EM Gigabit Ethernet

1

FIGURE 3-14. Configure Network (1/2) screen
9.  Select a network interface card for NIC1 (frontend0).
The Configure Netwotk (2/2) screen displays.
10. Select a network interface card for NIC2 (database0).
11.  Select Next.

The Web Console Settings screen displays.

FIGURE 3-15. Web Console Settings screen

12.  Select one of the following to determine the connection settings for the end-user
and management web consoles:
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. Select Yes to use the default connection settings.
+  Select No to modify the connection settings.

Once installation completes, the Log On screen for the command line interface
appeats.







Chapter 4

Installing on Virtual Machines

This chapter explains how to install SafeSync on virtual machines.

Topics in this chapter include:

Installing on V-Mware ESXi on page 4-2
Installing on Microsoft Hyper-1" on page 4-12

Installing on a V"Mware Workstation on page 4-29

Installing on an Oracle VM VirtualBox on page 4-50
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Installing on VMware ESXi

When installing SafeSync on a VMware ESXi, the virtual machine requires the following:

SYSTEM MINIMUM REQUIREMENT
Virtual machine VMware ESXi™ 4.x, 5.x
CPU 64-bit single core
RAM 8 GB
Hard disk 60 GB
Network cards Two NICs (1 GB recommended)
Note

The following procedure uses VMware ESXi 5.5.0 as an example.

Procedure

1. Launch VMware ESXi.

2.  Select File > New > Virtual Machine from the menu.
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3.

4.

The Create New Virtual Machine screen appeats.

Select the configuration for the virtual machine

Configuration

@ Typical

rating System Create a new virtual machine with the most common devices and configuration options.

" Custom

Ready to Complete Create a virtual machine with additional devices or specific configuration options.

() Create New Virtual Machine E@

Configuration Virtual Machine Version: 8

Help < Back | Next > I

Cancel

4

FIGURE 4-1. Configuration screen
Select Typical.

Click Next.

43
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The Name and Location screen appears.

pu
@ Create New Virtual Machine

Name and Location

Confiquration
Name and Location
Storage

Guest Operating System

Ready to Complete

=8 HoH %)

Virtual Machine Version: 8

Spedify a name and location for this virtual machine

Name:
SafeSync for Enterprise

Virtual machine (VM) names may contain up to 80 characters and they must be unique within each
vCenter Server VM folder.

VM folders are not viewable when connected directly to a host. To view VM folders and specify a location
for this VM, connect to the vCenter Server.

Help

4

FIGURE 4-2. Name and Location screen

Type a name for the virtual machine.

Click Next.
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The Storage screen appears.

pu
&) Create New Virtual Machine E

Storage Virtual Machine Version: 8
Select a destination storage for the virtual machine files

Confiquration Select a destination storage for the virtual machine files:

Name and Location - 8 — -
Storage Name Drive Type | Capacity | Provisioned Free | Type Thin Pro
Guest Operating System Non-SD 460.75 GB 545.34 GB 129.09 GB  VMFS5 Supporte
N ork

Create a Disk
Ready to Complete

< | n »
-
Name | Drive Type | Capacity | Provisioned Free | Type Thin Provi
< m »
Help <Back | Next > I Cancel
V

FIGURE 4-3. Storage screen

7.  Select a storage location for the virtual machine files.

8. Click Next.
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The Guest Operating System screen appears.

pu
&) Create New Virtual Machine E}

Guest Operating System Virtual Machine Version: 8
Spedify the guest operating system to use with this virtual machine

Configuration

Name and Location GuestOperting Syatens

Slorage " Windows
Guest Operating System
Sy " Linux
Network
@ Other |
Ready to Complete
Version:

(64-bit) v

Identifying the guest operating system here allows the wizard to provide the appropriate defaults for
the operating system installation.

Help <Back | Next > ] Cancel

4

FIGURE 4-4. Guest Operating System screen

9. Select Other and choose Other (64-bit) from the drop-down list.

10. Click Next.
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The Network screen appears.

.
&) Create New Virtual Machine (==

Network Virtual Machine Version: 8
Which network connections will be used by the virtual machine?

Confiouration Create Network Connections
Name and Location
Storage How many NICs do you want to connect? 2
Guest Operating System
Connect at
Network Adapter Power On
Ready to Complete
NIC 1: VM Network _~| [E1000 ~ ¥
NIC2: [private ~| [E1000 ~ &

=
L

If supported by this virtual machine version, more than 4 NICs can be added after the
virtual machine is created, via its Edit Settings dialog.

Adapter choice can affect both i e and migration Consult
the VMware KnowledgeBase for more information on choosing among the network adapters
operating syst: d hosts.

e el e

4

FIGURE 4-5. Network screen

11.  Select 2 NICs and specify the following settings.
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12.

TABLE 4-1. Network Settings for SafeSync

CONNECT
NAME NETWORK ADAPTOR | AT POWER
ON
NIC 1 VM Network E1000 Enabled
ﬁ’ Note
The VM network is the virtual
switch connected to the Internet
and/or Intranet. This switch may
have a different name in actual
environments.
NIC 2 Private E1000 Enabled
ﬁ’ Note
The private network is the private
virtual switch that is not
connected to the Internet and
Intranet. This switch may have a
different name in actual
environments.
Click Next.
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The Create a Disk screen appeats.

pu
(&) Create New Virtual Machine E]

Create a Disk
Specify the virtual disk size and provisioning policy

Virtual Machine Version: 8

Confiquration Datustore: R
Name and Location
Storage
Available space (GB): 129.1
Guest Operating System p2c= )
Network =
oy Virtual disk size: 3, v
Create a Disk : S 2 8

Ready to Complete

' Thick Provision Lazy Zeroed
 Thick Provision Eager Zeroed

€ Thin Provision

e el

4

FIGURE 4-6. Create a Disk screen
13.  Specify at least 60GB of disk space for SafeSync.

14. Select Thick Provision Lazy Zeroed.

15. Click Next.
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The Ready to Complete screen appears.

pu
&) Create New Virtual Machine @

Ready to Complete Virtual Machine Version: 8
Click Finish to start a task that will create the new virtual machine

Configuration Settings for the new virtual machine:
Name and Location
Shorere Name: SafeSyncfor Enterprise
Guest Operating System Host/Cluster: . ‘ —
Rehuork Resource Pool: User
Create a Disk Datastore: datastorel
Ready to Complete Guest 0S: Other (64-bit)
NICs: 2
NIC 1 Network: VM Network
NIC 1 Type: E1000
NIC2Network: Private
NIC 2 Type: E1000
Disk provisioning: Thick Provision Lazy Zeroed
Virtual DiskSize: 60 GB

[V Edit the virtual machine settings before completion

/3, Creation of the virtual machine (VM) does not indude automatic installation of the guest operating
system. Install a guest OS on the VM after creating the VM.

Help <Back | Continue ] Cancel

4

FIGURE 4-7. Ready to Complete screen

16. Sclect Edit the virtual machine settings before completion.

17.  Verify the settings for the new virtual machine and then click Continue.
The Virtual Machine Properties screen appears.

18. Open the Hardware tab and select Memory (adding).
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Memory Configuration appears in the right pane.

(&) SafeSync for Enterprise - Virtual Machine Properties EI@
Hardware | options | Resources |
. Memory Configuration
Show All Devices Add...
1011GBd  Memory Size: s [eB~
Hardware Summary s12aeH
@8 Memory (adding) 8192 MB ] ] g\fg’:‘g’gz"i;"l"l"gg'.‘de" AL
[ CPus (adding) 1 2@
. Maximum recommended for best
[ Video card (adding) Video card 128GBH 4 performance: 24572 MB.
353! VMCE devios (add"fg) Rés‘"deq 64 GBH Default recommended for this
2 New CD/DVD (adding) Client Device 4 guestOS: 512 MB.
& New Floppy (adding) Clent Device 3268y Minimum recommended for this
@® New SCSI Controller (add...  LSI Logic Parallel 16gell 9 guestos:64MB.
BB New NIC (adding) VM Network
BB New NIC (adding) Private 8GB
© New Hard Disk (adding) Virtual Disk e
2GBH
1GBH
512 MBHd
256 MBH
128 MBH
64 MBI
32 MBH
16 MBH
8MBH
4mpd
4

FIGURE 4-8. Memory Configuration screen

19. In the Memory Size field, select at least 8 GB.

20. From the Hardware tab, select CPU (adding).
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CPU settings appear in the right pane.

@ SafeSync for Enterprise - Virtual Machine Properties EI

Hardware !Opﬁons] Resources |

™ Show All Devices Add... Number of virtual sockets: 1 -

Hardware Summary Number of cores per socket: 2 -

# Memory (adding) 8192 MB

[ CPUs (adding) 2 | Total number of cores: 2

= Video card (adding) Video card At e ror e .
5 : : A inging the number of virtual CPUs after the gues

VMOl device (adding) Restricted 05 i installed might make your virtual machine

2 New CD/DVD (adding) Client Device unstable.

& New Floppy (adding) Client Device

e New SCSI Controller (add...  LSI Logic Parallel The virtual CPU configuration specified on this page

B9 New NIC (adding) VM Network might violate the license of the guest OS.

B9 New NIC (adding) Private

= New Hard Disk (adding) Virtual Disk

Help

Cancel

4

FIGURE 4-9. CPUs (adding) screen
21. In the Number of virtual sockets field, select 1.
22. In the Number of cores per socket field, select 2.
23. Click Finish.

The virtual machine is created.

Installing on Microsoft Hyper-V

Installing SafeSync on Microsoft Hyper-V requires the following:
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SYSTEM MINIMUM REQUIREMENT
Virtual machine Microsoft Hyper-V™ 6.2.9200.16384
CPU 64-bit single core
RAM 8GB
Hard disk 60GB
Network cards Two NICs (1GB recommended)
Note

The following procedure uses Microsoft Hyper-V 6.2.9200 as an example.

Procedure

1.  Launch Hyper-V Manager.

2.  Select the host servet.

3. Click Action > New > Virtual Machine from the main menu.

The New Virtual Machine Wizard screen appears.

413
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o New Virtual Machine Wizard -
’k} Before You Begin
This wizard helps you create a virtual machine. You can se virtual machines in place of physical

: computers for a variety of uses. You can use this wizard to configure the virtual machine now, and
Spedfy Name and Location you can change the configuration later using Hyper-V Manager.

S enery To create a virtual machine, do one of the folowing:

Configure Networking

: « Click Finish to create a virtual machine that is configured with default values.

Connect Virtual Hard Disk « Click Next to create a virtual machine with a custom configuration.

Installation Options

Summary

[] Do not show this page again

Next > Finish Cancel

FIGURE 4-10. New Virtual Machine Wizard screen

4. Click Next.

The Specify Name and Location screen appears.
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o~ New Virtual Machine Wizard -
* / Specify Name and Location
Before You Begin Choose a name and location for this virtual machine.

Specify Name and Location The name is displayed in Hyper-V Manager. We recommend that you use a name that helps you easiy
e Moy identify this virtual machine, such as the name of the guest operating system or workioad.

Configure Networking Neme:  [safesync for Enterprise

ComechVitial B bisic You can create a folder or use an existing folder to store the virtual machine. If you don't select a
Instalation Options folder, the virtual machine s stored in the defauit folder configured for this server.
Summary [[] store the virtual machine in a different location

D: \Virtual Machines\

‘ < Previous l ‘ Next > | l Finish | l Cancel

FIGURE 4-11. Specify Name and Location screen
5. Type a name for the virtual machine.

6. Click Next.

The Assign Memory screen appears.
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o~ New Virtual Machine Wizard -
*l Assign Memory
Before You Begin Spedify the amount of memory to allocate to this virtual machine. You can specify an amount from 8

MB through 29444 MB. To improve performance, spedfy more than the minimum amount recommended

Spedify Name and Location o e o sty st

ASSion Memocy Startup memory: 8192| MB
Configure Networking

e [] Use Dynamic Memory for this virtual machine.
onnect Virtual Hard Di
S @ When you decide how much memory to assign to a virtual machine, consider how you intend to
LEiakicoptors use the virtual machine and the operating system that t il run.
Summary

‘ < Previous l ‘ Next > | l Finish | l Cancel

FIGURE 4-12. Assign Memory screen

7.  Specify at least 8GB of startup memory.

Tip

Trend Micro recommends allocating 32GB of startup memory for optimal
performance.

8.  Specify whether memory is allocated dynamically or not.

ﬁ Note

Dynamically allocated space is allocated as the space fills up.

Fixed memory only takes as much space as you allocate, but is often faster to use.

9. C(lick Next.

The Configure Networking screen appeats.
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o~ New Virtual Machine Wizard -

pk/ Configure Networking

Before You Begin Each new virtual machine indudes a network adapter. You can configure the network adapter to use a
virtual switch, or it can remain disconnected.
Specify Name and Location

Assign Memory Connection: |Not Connected v

Configure Networking

Connect Virtual Hard Disk

Installation Options

Summary

l <PreviousJ l Next > ! l Finish ! l Cancel

FIGURE 4-13. Configure Networking screen
10. Under Connection, sclect Not Connected.

11. Click Next.

The Connect Virtual Hard Disk screen appears.
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o~ New Virtual Machine Wizard -

*l Connect Virtual Hard Disk

Before You Begin

A virtual machine requires storage so that you can install an operating system. You can specify the

Specify Namé and Location storage now or configure it later by modifying the virtual machine’s properties.

Assign Memory Create a virtual hard disk

e Use this option to reate a dynamically expanding virtual hard disk with the defauit format (VHDX).
Neme: [SafeSync for Enterprise.vhdx ]

Installation Options

Location: [C: Users\Public\Documents Hyper-V\Virtual hard disks\ | [ Browse... |

Size: GB (Maximum: 64 TB)

O Use an existing virtual hard disk
Use this option to attach an existing virtual hard disk, either VHD or VHDX format.

Summary

D: \Virtual Hard Disks\

O Attach a virtual hard disk later
Use this option to skip this step now and attach an existing virtual hard disk later.

‘ < Previous l ‘ Next > | l Finish | l Cancel

FIGURE 4-14. Connect Virtual Hard Disk screen
12. Specify at least 60GB of disk space for SafeSync.
13. Click Next.

The Installation Options screen appears.

14. Select Install an operating system from a boot CD/DVD-ROM.

15.  Select one of the following options.
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. Physical CD/DVD drive: Use the drop-down list to select a drive.

o~ New Virtual Machine Wizard -
pk/ Installation Options
Before You Begin

You can install an operating system now if you have access to the setup media, or you can install it
later.
Spedfy Name and Location =T

Assign Memory O Install an operating system later
Configure Networking ® Install an operating system from a boot CD/DVD-ROM
Connect Virtual Hard Disk Media

® Physical CD/DVD drive:
Summary

O Image file (.iso): sktop)

O Install an operating system from a boot floppy disk

|<PreviousJ| Next > H Finish H Cancel J

FIGURE 4-15. Installation Options screen - Install an operating system later
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Image file (.iso): Click Browse and locate the SafeSync .iso file.

n

New Virtual Machine Wizard .

tk, Installation Options

Before You Begin

You can install an operating system now if you have access to the setup media, or you can install it
later.
Spedify Name and Location 5

AssionMemcy O Install an operating system later

Configure Networking ® Install an operating system from a boot CD/DVD-ROM
Connect Virtual Hard Disk Media

O Physical CD/DVD drive: |E:
Summary

® Image file (iso): [1Desktop\SafesyncForEnterprise-2.1-5PLiso | [ Browse...

O Install an operating system from a boot floppy disk

l <PreviousJ l Next > | l Finish l Cancel

FIGURE 4-16. Intallation Options screen - Install an operating system from
a boot CD/DVD-ROM

16. Click Next.

The Completing the New Virtual Machine Wizard screen appears.
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o~ New Virtual Machine Wizard -

pk/ Completing the New Virtual Machine Wizard

Before You Begin You have successfully completed the New Virtual Machine Wizard. You are about to create the
following virtual machine.
Specify Name and Location

Assign Memory EEEIE
Configure Networking Name: SafeSync for Enterprise
Connect Virtual Hard Disk S glcame
Network: Not Connected
Installation Options Hard Disk: C:\Users\Public\Documents\Hyper-V\Virtual hard disks\SafeSync for Enterprise.vi
Operating System: Wil b installd from E:
2 m >

To create the virtual machine and dose the wizard, dick Finish.

FIGURE 4-17. Completing the New Virtual Machine Wizard screen
17.  Verify that the settings are correct.
18. Click Finish.
The SafeSync virtual machine appears in the VM List.
19. Select the SafeSync virtual machine.
20. Create an external virtual switch.

a.  Select Action > Virtual Switch Manager.
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The Virtual Switch Manager screen appears.

g irtual Switch Manager for =]
2 Virtual Switch M for WIN2012 [= = [
A _Virtual Switches A Create virtual switch
AT New virtual network switch
% Global Network Settings What type of virtual switch do you want to create?

U MAC Address Range

Create Virtual Switch

Creates a virtual switch that binds to the physical network adapter so that virtual
machines can access a physical network.

o e ]

FIGURE 4-18. Virtual Switch Manager screen

b.  Select External.
c.  Click Create Virtual Switch.
21. Specify the settings of the external virtual switch.

a.  Under Virtual Switches, select the new virtual switch.
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The Virtual Switch Properties panel is updated.

A Virtual Switch Manager for WIN2012 [= o |

r

A Virtual Switches Wi\ Virtual Switch Properties
A New virtual network switch

i Realtek PCle GBE Family Controller ... [ Ik
Realtek PCle GBE Family Controller Realtek PCle GBE Family Controller - Virtual Switch
#_Global Network Settings
= Notes:
U MAC Address Range
Connection type

What do you want to connect this virtual switch to?

@® External network:

[Realtek PCte GBE Family Controller v

[¥] Allow management operating system to share this network adapter

Internal network

O Pprivate network

VLAN ID
[] Enable virtual LAN identification for management operating system

Remove

‘@‘ SR-IOV can only be configured when the virtual switch is created. An external
virtual switch with SR-IOV enabled cannot be converted to an internal or private
switch.

.

FIGURE 4-19. Virtual Switch Manager screen
b.  Type a name for the virtual switch.
c.  Select External network.
d.  Select a network switch from the drop-down list.

e.  Select Allow management operating system to share this network
adapter.

f.  Click Apply.
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A confirmation screen appears. Click Yes.

ER Virtual Switch Manager for WIN-SFTINESEGE [=[=

|A VirtualSwitches | % virtual Switch Properties

New virtual network switch

External network o

Intel(R) Gigabit CT Desktop A... | [External network
2 _Global Network Settings e

0 MAC Address Range s
Apply Networking Changes \L’
i Pending changes may disrupt network
~ connectivity
v
This computer may lose its network ion while

the changes are applied. This may affect any network ithis network adapter
operations in progress. These changes also may
overwrite some static changes, If that happens, you
must reapply the static changes to restore network
connectivity. Do you want to continue?

[0 Please don't ask me again

perating system

Remove

@: SR-IOV can only be configured when the virtual switch is created. An external
virtual switch with SR-IOV enabled cannot be converted to an internal or private
switch.

FIGURE 4-20. Apply Networking Changes screen

22. Create an internal virtual switch.

a.  Under Virtual Switches, click New virtual network switch.
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The Virtual Switch Manager screen appears.

& Virtual Switch Manager for WIN2012 [= [= |
# Virtual Switches | & create virtual switch
A New virtual network switch
" Realtek PCle GBE Family Contr... | What type of virtual switch do you want to create?
Realtek PCle GBE Family Cont... | [External
#_Global Network Settings ternal |
U MAC Address Range Private

Create Virtual Switch

Creates a virtual switch that can be used only by the virtual machines that run on this
physical computer, and between the virtual machines and the physical computer. An
internal virtual switch does not provide connectivity to a physical network connection.

‘ oK [ ‘ Cancel \ ‘ Apply ‘

FIGURE 4-21. Virtual Switch Manager screen

b.  Select Internal.
c.  Click Create Virtual Switch.

23. Specify the settings of the internal virtual switch.

a.  Under Virtual Switches, select the new virtual switch.
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& Virtual Switch Manager for WIN2012 [= [= |
|A VirtualSwitches | A virtual Switch Properties
A New virtual network snitch
Realtek PCle GBE Family Controller ... [ Name:

[nternal virtual switch

Notes:

A _Global Network Settings ~
U MAC Address Range

Connection type
What do you want to connect this virtual switch to?
O External network:

Realtek PCle GBE Family Controller

Internal network

Private network

VLAN ID
[] Enable virtual LAN identification for management operating system

Remove

@ SR-IOV can only be configured when the virtual switch is created. An external
virtual switch with SR-IOV enabled cannot be converted to an internal or private
switch.

‘ oK [ ‘ Cancel \ Apply ‘

FIGURE 4-22. Virtual Switch Manager screen
b.  Type a name for the virtual switch.

c.  Select Internal network.

24. Click Apply.




Installing on Virtual Machines

The Virtual Machines list appears.

3a Hyper-V Manager [Lli-

File Action View Help
«o 25 @
B e =

WIN2012
i = = WIN2012 -
Virtual Machines
New »
Name State CPUUtage  Assigned Memory  UBHI | 4 oot Vitual Mschine..
3 sefe 1259 (inoc3.8) off
3 SSFE 1259 server (actress)  OFf %] Hyper-V Settings...
5 SSFE_KemelUpgrade Off Z1 Virtual Switch Manager...
JEEEEEET Con . Virtual SAN Manager...
Seti ¢ Edit Disk...
Start (& Inspect Disk...
Snapshot (@) Stop Service
< { R s
[ ove.. [ f emove Server
Snapshots Export... (@ Refresh
Rename... View >
Delete... rapshats. H Hep
Enable Replication. AT =
(el S| & Connect..
54 Settings..
= © stert
SafeSync for Enterprise =
T Snapshot
Created: 2014/7/9 F4F 06:0319 Clustered: No 5 Move..
Notes:  None &) Egott..
=] Rename...
S¢ Delete..
g
Summary | Memory | Networking | Replication |
H Hep
< w >

FIGURE 4-23. Virtual Machines list
25. Right-click the SafeSync virtual machine.
26. Sclect Settings.

The Settings screen appears.

27. Configure the network settings of the external switch.

a.  Under Hardware, sclect Network Adapter.
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The Network Adapter screen appears.

Bl Settings for SafeSync for Enterprise on WIN2012 |;li-
SafeSync for Enterprise v > G
A Hardware ~ | @ Network Adapter
¥ Add Hardware

BIOS Spedify the configuration of the network adapter or remove the network adapter.
om CD Virtual switch:

|Realtek PCle GBE Family Controller - Virtual Switch v |

Not connected

Realtek PCle GBE Family Controller - Virtual Switch
Internal Virtual Switch

]

EE IDE Controller 0
& Hard Drive

© B IDE Controller 1 2

@o

P eE Bandwidth Management
®2 sCSI Controller [] Enable bandwidth management
® § network Adapter i
Realtek PCle GBE Family C... |=

[ Diskette Drive o
None
|A Management | To remove the network adapter from this virtual machine, dick Remove.
|L] Name
-
v 5
= B @ Use alegacy network adapter instead of this network adapter to perform a
A e network-based installation of the quest operating system or when integration
15 Snapshot File Location services are not installed in the quest operating system.
1 Snap:

24 smart Paging File Location

19 Automatic Start Action

q v

[ OK ‘ [ Cancel ‘ [ Apply ‘

FIGURE 4-24. Network Adapter screen

b.  Under Network Adapter, select the previously created external switch from
the drop-down list.

28. Configure the network settings of the internal switch.
a.  Under Hardware, click Add Hardware.
The Add Hardware screen appears.

b.  Select Network Adapter.

c. Click Add.
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The new network adapter appears under the Hardware pane.

= Settings for SafeSync for Enterprise on WIN2012 [= = [
SafeSync for Enterprise v > G
A Hardware ~

U Network Adapter

dd Hardware
Spedify the configuration of the network adapter or remove the network adapter.
om CD Virtual switch:

[rnternal virtual switch v

Not connected

Realtek PCIe GBE Family Controller - Virtual Switch
Internal Virtual Switch

= il IDE Controller 0

= Hard Drive
© B IDE Controller 1 2
£ DVD Drive

eE: Bandwidth Management
& SCSI Controller ["] Enable bandwidth management
® U Network Adapter
Realtek PCle GBE Family C...
@ © Network Adapter
Internal Virtual Switch a 0

©

To remove the network adapter from this virtual machine, dick Remove.

Remove

@ Use alegacy network adapter instead of this network adapter to perform a
network-based installation of the guest operating system or when integration
services are not installed in the guest operating system.

1] Snapshot File Location

mart Paging File Location

g
o

‘ oK [ ‘ Cancel \ ‘ Apply ‘

FIGURE 4-25. Network Adapter screen
d.  Under Network Adapter, select Internal Virtual Switch.

29. Click OK.

The virtual machine is created.

Installing on a VMware Workstation

Tip

Trend Micro does not recommend installing SafeSync on a VMware Workstation virtual
machine.
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When installing SafeSync on a VMware Workstation, the virtual machine requires the

following:
SYSTEM MINIMUM REQUIREMENT
Virtual machine VMware® WorkStation™ 6.x, 7.x or above
CPU 64-bit single core
RAM 8GB
Hard disk 60GB
Network cards Two NICs (1GB recommended)
Note

The following procedure uses VMware Workstation 9.0.3 as an example.

Procedure
1. Launch a VMware WorkStation.

2. Select File > New > Virtual Machine from the menu.
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A setup wizard appears.

New ¥irtual Machine Wizard x|

Welcome to the New Virtual
Machine Wizard

‘What type of configuration do you want?

" Typical (recommended)

Create a Workstation 9.0 virtual machine
in a few easy steps.

& Custom (advanced)

Create a virtual machine with advanced
options, such as a SCSI controller type,
VMware® virtual disk type and compatibility with

» older YMware products.
Workstation 9

Help I < Back | Next > I Cancel

FIGURE 4-26. Virtual Machine Configuration

3. Select Custom (advanced).

4. Click Next.
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The Virtual Machine Hardware Compatibility screen appears.

New Yirtual Machine Wizard

Choose the Yirtual Machine Hardware Compatibility
Which hardware features are needed for this virtual machine?

—Y¥irtual machine hardware compatibility

Hardware compatibility: v

Compatible with: [V E5x Server

Compatible products: Limitations:
ESX 5.0 =] 64 GB memory limit Al
Fusion 4.0 8 processor limit
Fusion 5.0 10 network adapter limit
Workstation 8.0 2 TB disk size limit

Workstation 9.0

ke I

Help I < Back I Next > I Cancel I

FIGURE 4-27. Virtual Machine Hardware Compatibility screen

5.  Select Workstation 8.0 from the drop-down list.

6. Click Next.
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The Guest Operating System Installation screen appears.

New Yirtual Machine Wizard . x|

Guest Operating System Installation

A virtual machine is like a physical computer; it needs an operating
system. How will you install the quest operating system?

Install from:

" Installer disc:

2 DVD Drive (F:) j

" Installer disc image file (iso):

I E|

Browse. ..

1 will install the operating system later.:

The virtual machine will be created with a blank hard disk.

Help I < Back I Next > I Cancel

FIGURE 4-28. Guest Operating System Installation screen

7.  Select I will install the operating system later..

8. Click Next.
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The Select a Guest Operating System screen appears.

New Virtual Machine Wizard a x|

Select a Guest Operating System
Which operating system will be installed on this virtual machine?

—Guest operating system

" Microsoft Windows
% Linux

" Novell Net\Ware
" Sun Solaris

" VMware ESX

" Other

—Version

ibuntu 64-bit ¥

Help I < Back I Next > I Cancel

FIGURE 4-29. Select a Guest Operating System screen

9.  Specify the following:
*  Guest operating system: Other

. Version: Other 64-bit

10. Click Next.
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The Name the Virtual Machine screen appeats.

New Yirtual Machine Wizard . x|

Name the Yirtual Machine
What name would you like to use for this virtual machine?

Virtual machine name:

I SafeSyncFor Enterprise

Location:

I D:\vmware\SafeSyncForEnterprise Browse... I

The default location can be changed at Edit > Preferences.

< Back I Next > I Cancel

FIGURE 4-30. Name the Virtual Machine screen

11.  Type a name for the virtual machine.

12. Type a path for file storage.

13. Click Next.
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The Processor Configuration screen appears.

New Yirtual Machine Wizard . x|

Processor Configuration
Specify the number of processors for this virtual machine.

Processors

Number of processors: ll 'I
Mumber of cores per processor: I 1 Y I

Total processor cores: 1

Help I < Back I Next > I Cancel I

FIGURE 4-31. Processor Configuration screen

14. Provide the number of processors and the number of cores per processor that the

virtual machine uses.

15. Click Next.
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The Memory for the Virtual Machine screen appears.

New Yirtual Machine Wizard . x|
Memory for the Yirtual Machine
How much memory would you like to use for this virtual machine?
Specify the amount of memory allocated to this virtual machine. The memory size
must be a multiple of 4 MB.
E4GB - Memory for this virtual machine: | 8192 _l::' MB
32GB -
16GB - <
8GB -
4GB _\'_I 2 Maximum recommended memory:
2GB - 17812 MB
1GB - <
S12MB - <] [@ Recommended memory:
256 MB - 1024 MB
128 MB -
64MB - [J Guest OS recommended minimum:
32MB - 512 MB
1EMB -
8MB -
4MB -
Help I < Back I Next > I Cancel

FIGURE 4-32. Memory for the Virtual Machine screen

16. Specify at least 8GB RAM for SafeSync.

17. Click Next.
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The Network Type screen appears.

New Yirtual Machine Wizard N

Network Type
What type of network do you want to add?

~Network connection

network, The guest must have its own IP address on the external network.

" Use network address translation (NAT)
Give the guest operating system access to the host computer's dial-up or
external Ethernet network connection using the host's IP address.

" Use host-only networking
Connect the guest operating system to a private virtual network on the host
computer.

" Do not use a network connection

Help I < Back I Next > I Cancel

FIGURE 4-33. Network Type screen

18. Sclect Use bridged networking.

19. Click Next.
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The Select I/O Controller Types scteen appeats.

New Yirtual Machine Wizard . x|

Select 1/0 Controller Types
Which SCSI controller type would you like to use?

1fO controller types
IDE Controller: ATAPI

SCSI Controller: ¢ Buslogic (Mot available for 64-bit guests)
(O] {Recommended)

" LSI Logic SAS

Help I < Back I Next > I Cancel

FIGURE 4-34. Select I/O Controller Types screen

20. Select LSI Logic (Recommended).

21. Click Next.
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The Select a Disk screen appears.

New ¥irtual Machine Wizard N

Select a Disk
Which disk do you want to use?

Disk

% Create a new virtual diski
A virtual disk is composed of one or more files on the host file system, which
will appear as a single hard disk to the guest operating system. Virtual disks
can easily be copied or moved on the same host or between hosts.,

" Use an existing virtual disk
Choose this option to reuse a previously configured disk.

" Use a physical disk (for advanced users)

Choose this option to give the virtual machine direct access to a local hard
disk.

Help I < Back I Next > I Cancel

FIGURE 4-35. Select a Disk screen

22. Select Create a new virtual disk.

23. Click Next.
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The Select a Disk Type screen appears.

New Yirtual Machine Wizard E x|

Select a Disk Type
‘What kind of disk do you want to create?

Virtual disk type
" IDE

o §CSI {Recommended)

Help I < Back I Next > I Cancel

FIGURE 4-36. Select a Disk Type screen

24. Sclect the SCSI (Recommended) disk type.

25. Click Next.
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The Specify Disk File screen appears.

New Yirtual Machine Wizard . x|

Specify Disk File
Where would you like to store the disk file?

Disk File

One disk file will be created for each 2 GB of virtual disk capacity. File names for
each file beyond the first will be automatically generated using the file name
provided here as a basis.

Browse... I

Help I < Back I Next > I Cancel

FIGURE 4-37. Specify Disk File screen

26. Specify where to store the disk file.

27. Click Next.
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The Specify Disk Capacity screen appears.

New Yirtual Machine Wizard . x|

Specify Disk Capacity
How large do you want this disk to be?

Maximum disk size (GB): I 60 _,?

Recommended size for Ubuntu 64-bit: 20 GB

™ allocate all disk space now.

Allocating the full capacity can enhance performance but requires all of the
physical disk space to be available right now. If vou do not allocate all the
space now, the virtual disk starts small and grows as you add data to it.

" Store virtual disk as a single file
&+ split virtual disk into multiple files

Splitting the disk makes it easier to move the virtual machine to another
computer but may reduce performance with very large disks.

Help I < Back I Next > I Cancel

FIGURE 4-38. Specify Disk Capacity screen

28. Specify at least 60GB of disk space for SafeSync.

29. Click Next.
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The Ready to Create Virtual Machine screen appears.

New Yirtual Machine Wizard i

Ready to Create Yirtual Machine

Click Finish to create the virtual machine. Then you can install Ubuntu
64-bit.

The virtual machine will be created with the following settings:

MName: SafeSyncFor Enterprise
Location: D:\vmware\SafeSyncForEnterprise
Version: Workstation 8.0

Operating System: Ubuntu 64-bit

Hard Disk: 60 GB, Split

Memory: 8192 MB

MNetwork Adapter:  Bridged {Automatic)

Other Devices: CD/DVD, Floppy, USB Controller, Printer, Sound Card

Customize Hardware. ..

< Back I Finish I Cancel

FIGURE 4-39. Ready to Create Virtual Machine screen

30. Click Customize Hardware.
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The Hardware screen appears.

y

| ~Device status

Device ] Summary
W Memory 8GB J™ | Connected
[ Processors 1 [V Connect at power on
*JNew CD/DYD (... Auto detect
(= Floppy Auto detect ~Connection
EINetwork Adapter Bridged (Automatic) & Use physical drive:
USB Controller  Present
‘6‘ ) Sound Card Auto detect m]
= Printer Present € Use ISO image file:
Spisplay Auto detect I—ZI o

Advanced...

Add... Remove

FIGURE 4-40. Hardware screen
31. Select New CD/DVD.

The Select New CD/DVD scteen appeats.
32. Under Device status, sclect Connect at power on.
33. Under Connection, select one of the following,

+  Use phyiscal drive: Use the drop-down list to select a drive.

4-45
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+  Use ISO image file: Click Browse and locate the SafeSync .iso file.

y

[ Device status

Device ] Summary [
S Memory 8GB J™ | Connected
[ Processors 1 [V Connect at power on

*JNew CD/DYD (... Auto detect
(= Floppy Auto detect ~Connection
@Network Adapter Bridged (Automatic) € Use physical drive:
USB Controller  Present
@) Sound Card Auto detect JF: IZ|
= Printer Present & Use ISO image file:

Spisplay Auto detect

Browse...

Advanced...

Add... Remove

FIGURE 4-41. Hardware screen

34. Click Add.
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The Hardware Type screen appears.

Hardware . x|

Device | summary | Device status

S Memory 8GB ’V J™ | Connected

[ Processars 1 = 7 Connack sk nower an

R . ordore wizord x

Floppy Hardware Type

network Adap What type of hardware do you want to install?

USE Controller

@) Sound Card X I

d=hPrinter Hardware lanati

Spisplay *)CDJDVD Drive Add a network adapter.
[ Floppy Drive Browse...
@Netwmk Adapter

USB Controller Advanced...

@ ) Sound Card
E Parallel Port
@ Serial Port
(= Printer

Generic 5CS1 Device

< Back I Mext > Cancel

Add... Remove

|

FIGURE 4-42. Hardware Type screen

35. Select Network Adapter.

36. Click Next.
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The Network Adapter Type screen appears.

Hardware T = x|
Betee | Summary ‘ Device status
9 Memory 8GB ™ | Connected
[ Processors 1 I7 Connack sk nouwer on
) New CD/DVD ( G R 8 x|
Floppy Network Adapter Type
Tnetwork Adap What type of network adapter do you want to add?
USB Controller
)Sound Card el
‘ﬂ n.un d Network i
=) Printer
Wpisplay " Bridged: Connected directly to the physical network
> Browse...
I™ | Replicate physical network conmection state =

€ NAT: Used to share the host's IP address
Advanced...
" Host-only: A private network shared with the host

' Custom: Specific virtual network

ytnet2 |
W
VMnet1 (Host-onl:

De:

E VMnet3
VMnet4
VMnets
VMneté
VMnet7
Mnets (NAT) Cancel
VYMnetd

Add... Remove

FIGURE 4-43. Network Adapter Type screen

37. Sclect Custom and specify a virtual network from the drop-down list.

Tip
Trend Micro recommends using any of the virtual networks between VMnet2 to
VMnet7.

38. Select Connect at power on.

ﬁ Note

Take note of the virtual machine settings. The network adapater settings should be
identical on both servers in a high availability deployment.

39. Click Finish.
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The Hardware screen appears.

Hardware | Options I

[ Device status

Device \ Summary
W Memory 8GB I= | Connected
[ Processors 1 [V Connect at power on
AHard Disk (SCSI) 60GB
* ) CDJDYD (IDE) Using file C:\Documents and Setti... ~Network connection
[ Floppy Auto detect (% Bridged: Connected directly to the physical network.

I Replicate physical network connection state

MNetwork Adapter 2 Custom (¥YMnet2)

US Contraller Present " WAT: Used to share the host's IP address
‘ﬁ‘ Séund Card Auto detect € Host-only: & private network shared with the host
Al Present € Custom: Specific virtual network
Spisplay Auto detect
Jvtneto (Auto-bridging) =

" LAN segment:

I K|
LAN Segments... | Advanced...

Add... Remove

oK I Cancel Help

FIGURE 4-44. Hardware screen

40. Click OK.
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The virtual machine is created.

9 safeSyncForEnterprise - ¥Mware Workstation i (=] 3}
File Edit View VM Tabs Help
| AR R ol =5 S

Home: (1 safeSyncForEnterprise

(1) SafeSyncForEnterprise

P> Powier on this virtual machine
P Edit virtual machine settings

(i3 Uparade this virtual machine

v Devices
i Memory 8GB
[ Processors 1
(Z\Hard Disk (SCSI) 60 GB
) COJDVD (IDE) Auto detect
[= Floppy Auto detect

FENetwork Adapter  Bridged (Automatic)
& Network Adapter 2 Custom (VMnet2)
USB Controller Present

@) Sound Card Auto detect
(i Printer Present
WDisplay Auto detect

¥ Description

ription of this

irtual machine

¥ Virtual Machine Details
State: Powered off
Configuration file: F i afeSyncF iSe. vmx
Hardware compatibility: Workstation 8.0 virtual machine

FIGURE 4-45. SafeSync Virtual Machine

Installing on an Oracle VM VirtualBox

Tip
Trend Micro does not recommend installing SafeSync on an Oracle VM VirtualBox virtual
machine.

When installing SafeSync on an Oracle VM VirtualBox, the virtual machine requires the

following:
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SYSTEM MINIMUM REQUIREMENT
Virtual machine Oracle VM VirtualBox™ 4.2.x
CPU 64-bit single core
RAM 8GB
Hard disk 60GB
Network cards Two NICs (1GB recommended)
Note

The following procedure uses Oracle VM VirtualBox 4.3.14 as an example.

Procedure
1. Log on to the Oracle VM VirtualBox.

2. Click the New button on the toolbar to add a new virtual machine.

3. C(lick Next.

4-51
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The Name and operating system screen appears.

9 Oracle VM VirtualBox Manager =|9] x

{:} s 7 4 _ (©3 Snapshots
New Settings Start Discard
Welco| | CreateVirtual Machine
The left] . s empty now because you haven't
created Name and operating system &
o] Please choose a descriptive name for the new virtual machine [l *2=4 57 9 N\,
and select the type of operating system you intend to install g
You'an onit. The name you choose wil be used throughout VirtualBox | fast A
informaf to identify this machine. g.l
Name: [ssFe | N 7]
Type: [Linux

Version: [Ubuntu (64 bit)

ride Description] | Next | [ cCancel

FIGURE 4-46. Name and operating system screen

4. Type a name for the virtual machine.

5. Select the following for the operating system type and version:
. Linux

- Ubuntu (64-bit)

6. Click Next.
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7.

8.

The Memory size screen appears.

(€)  Create Virtual Machine

Memory size

allocated to the virtual machine.

4MB

Select the amount of memory (RAM) in megabytes to be

The recommended memory size is 512 MB.

8192 MB

Next

| I Cancel

FIGURE 4-47. Memory size screen

Specify at least 8GB RAM for SafeSync.

Click Next.
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The Hard drive screen appears.

:

(€)  Create Virtual Machine

Hard drive

If you wish you can add a virtual hard drive to the new
machine. You can either create a new hard drive file or select
one from the list or from another location using the folder icon.

If you need a more complex storage set-up you can skip this
step and make the changes to the machine settings once the
machine is created.

The recommended size of the hard drive is 8.00 GB.

(O Do not add a virtual hard drive
(® Create a virtual hard drive now
(O Use an existing virtual hard drive file

Empty .

Create || Cancel

FIGURE 4-48. Hard drive screen

9. Select Create a virtual hard drive now.

10. Click Create.
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The Hard drive file type screen appears.

:

.~ Create Virtual Hard Drive

Hard drive file type

Please choose the type of file that you would like to use for the new virtual
hard drive. If you do not need to use it with other virtualization software you
can leave this setting unchanged.

(® VDI (VirtualBox Disk Image)
(O VMDK (Virtual Machine Disk)

(O VHD (virtual Hard Disk)

(O HDD (Parallels Hard Disk)

(O QED (QEMU enhanced disk)

O QCow (QEMU Copy-On-Write)

Hide Descriptionl | Next I | Cancel

FIGURE 4-49. Hard drive file type screen

11.  Specify the type of virtual disk to use.

Tip
If you do not intend to use the virtual machine with other virtualization software,
leave the setting as VDI (VirtualBox Disk Image).

12. Click Next.
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The Storage on physcial hard drive screen appears.

B

(€)  Create Virtual Hard Drive

Storage on physical hard drive

Please choose whether the new virtual hard drive file should grow as it is used
(dynamically allocated) or if it should be created at its maximum size (fixed
size).

A dynamically allocated hard drive file will only use space on your physical

hard drive as it fills up (up to @ maximum fixed size), although it will not shrink
again automatically when space onitis freed.

A fixed size hard drive file may take longer to create on some systems butis
often faster to use.

® Dynamically allocated

O Fixed size

Next l | Cancel

FIGURE 4-50. Storage on physcial hard drive screen

13.  Specify whether disk space is allocated dynamically or if disk space is fixed.

ﬁ Note

Dynamically allocated space is allocated as the space fills up.

Fixed disk space only takes up as much space as you allocate, but the fixed size disk is
often faster to use.

14. Click Next.
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The File location and size screen appears.

:

(€)  Create Virtual Hard Drive

File location and size

Please type the name of the new virtual hard drive file into the box below or
dick on the folder icon to select a different folder to create the file in.

SSFE I [3

Select the size of the virtual hard drive in megabytes. This size is the limit on
the amount of file data that a virtual machine will be able to store on the hard

drive.
60.00 GB

4.00 MB 2.00TB

Create ll Cancel

FIGURE 4-51. File location and size screen
15. Specify a name and location for the virtual disk.

16. Specify at least 60GB of disk space for SafeSync.

17. Click Create.
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The virtual machine appears in the virtual machine list.

9 Oracle VM VirtualBox Manager [- [

File Machine Help

o [@oeat] @ srapsos

New Settings Start Discard

= General E preview

Name: SSFE
Operating System: Ubuntu (64 bit)

IB System

Base Memory: 8192MB
BootOrder:  Floppy, CD/DVD, Hard Disk
Acceleration:  VT-x/AMD-Y, Nested Paging

Display

Video Memory: 12M8
Remote Desktop Server: Disabled
Video Capture: Disabled

Storage
Controller: IDE
IDE Secondary Master:  [CD/DVD] Empty
Controller: SATA
SATA Port 0: SSFE.vdli (Normal, 60.00 GB)
# Audio

Host Driver: Windows DirectSound
Controller:  ICH AC97

&P Network

Adapter 1: Intel PRO/1000 MT Desktop (NAT)
& uss

Device Filters: 0 (0 active)

[l Shared folders

None

& Description

None

FIGURE 4-52. Virtual Machine Summary screen
18. Select the SafeSync virtual machine from the list.

19. Click Settings from the main menu to set up the environment for SafeSync.
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The Settings screen for the virtual machine appears.

@&

Oracle VM VirtualBox Manager =i |REV| e

5‘“1 N %
: o
1@ SSFE - Settings
New
m Y5 4 @. General Storage ~
4 Iﬂ System
Storage Tree Attributes
Display
- & Covolr e || copoone: sy o]q)
2 torage —————————.
I 9 [ Live coppvD ‘@ Choose a virtual CD/DVD disk fie...
Audi
| ) uee £ Controller: SATA Information ‘ Host Drive 'F:
|& Network Typel
?@ Serial Ports e oo - | @ | Remove disk from virtual drive
| & use Location: - J
|
[ Attached to: =
[ Shared Folders
BE&&
ok | [ concel |[ hHep |

5 Audio

Host Driver: Windows DirectSound
Controller:  ICH AC97

&P Network

Adapter 1:  Intel PRO/1000 MT Desktop (NAT)

v

FIGURE 4-53. Settings - Storage screen
20. Mount the SafeSync installation CD/DVD ot import the SafeSync .iso file.
a.  Click Storage from the left pane of the Settings screen.
The content for Storage appears.
b.  Select Controller: IDE.

c.  Right-click the CD/DVD drop-down list and select either a physical dtive or
a virtual CD/DVD disk file.

The SafeSync installation files are ready to be installed.

21. Add a host-only network.

a.  Go to File > Preferences.
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) Oracle VM VirtualBox Manager [=[=

File | Machine Help
& | Virtual Media Manager... Ctrl+D
@ | Import Appliance... Ctrl+l [ 23 petais | @ snapshots
(R | Export Appliance... Ctrl+E
E preview
[ Preferences... Cti+G ||
SSFE

@ | Bt Ctie@ [ Ubuntu (64bit)

m System

Base Memory: 8192MB

Boot Order: Floppy, CD/DVD, Hard Disk

Acceleration:  VT-x/AMD-Y, Nested Paging

Display

Video Memory: 12MB

Remote Desktop Server: Disabled

Video Capture: Disabled

Storage
Controller: IDE
IDE Secondary Master:  [CD/DVD] Empty
Controller: SATA
SATA Port 0: SSFE.vdli (Normal, 60.00 GB)
# Audio

Host Driver: Windows DirectSound
Controller:  ICH AC97

&P Network

& uss

Device Filters: 0 (0 active)
[l Shared folders
None

& Description

None

Display the global settings window

FIGURE 4-54. Oracle VM VirtualBox File menu

The VirtualBox - Settings screen appears.
b.  Click Network from the left pane.
The Network screen appeats.

c.  Click the Host-only Networks tab.
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i) Oracle VM VirtualBox Manager = =] e

W R

New Settings Start Discard

= General

& VirtualBox - Settings

5 General Network
[#) Input

@ Update

@ Language =
Display Add host-only network (Ins)
& Network
[ Extensions

[ Proxy

NAT Networks | Host-only Networks |

HOSTDNVErT  WINGoWS DIrectsouna
Controller:  ICH AC97

&P Network

& uss

Device Filters: 0 (0 active)
[l Shared folders
None

& Description

None

FIGURE 4-55. Host-only Networks tab

d.  From the right-hand toolbar, click the Add host-only network (Ins) icon

(k-
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A new host-only network is added to the list.

& VirtualBox - Settings (> |

= General Network

E] Input
NAT Networks Host-only Networks
@ Update

VirtualBox Host-Only Ethernet Adapter

@ Language
Display
@ Network
D Extensions
Proxy

S EE

[ ok ][ cancel |[ Heb

FIGURE 4-56. New host-only network added
e.  Select the newly created host-only network.
f.  Click OK

22. Specify the network settings of Adapter 1.

ﬁ Note

In Oracle VM VirtualBox Manager, Adapter 1 functions as the SafeSync frontend0
NIC card and Adapter 2 functions as the SafeSync database0 NIC card.

For more information, see Roles of the Network Interface Cards on page 2-10.

a.  Select the SafeSync virtual machine from the list.
b.  Click Settings from the main menu.

The Settings screen for the virtual machine appears.

c.  Click Network from the left pane of the Settings screen.
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The content for Network appears.

) SSFE - Settings [ |

@ General Network

[E7) System o

Display Adapter 1 | Adapter 2 | Adapter3 | Adapter4

Storage [V Enable Network Adapter

B Audio Attached to:

@ Network Name: ]RealhekPCIeGBEFamllyConudler v
& Serial Ports B> Advanced

& uss

[ Shared Folders

l OK H Cancel Il Help

FIGURE 4-57. Settings - Network (Adapter 1) screen
d.  Select Enable Network Adapter.
e.  Under Attached to, sclect Bridged Adapter.
f.  Under Name, select a network adapter from the list.

23. Specify the network settings of Adapter 2.

a.  Click Adapter 2.
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The Adapter 2 tab displays.

) SSFE - Settings (=

= General Network

Storage [V] Enable Network Adapter

B Audio Attached to:

@ Network Name: [VnuaIBox Host-Only Ethernet Adapter v
¢ Serial Ports B Advanced

& use

[ Shared Folders

‘ OK | | Cancel | | Help

FIGURE 4-58. Settings - Network (Adapter 2) screen
b.  Select Enable Network Adapter.
c.  Under Attached to, select Host-only Adapter.
d.  Under Name, select the host-only adapter from the drop-down list.
24. Click OK.

The virtual machine is created.
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This chapter explains how to verify a SafeSync installation.

Topics in this chapter include:

Veerifying File Upload and Download on page 5-2
Checking System Status on page 5-5
Checking Services on page 5-6

Verifying MySQL HA on page 5-7

Veerifying File Replication on page 5-10




SafeSync for Enterprise Installation Guide

Verifying File Upload and Download

After installing SafeSync, Trend Micro recommends testing the installation.

Procedure

1. Using a web browser, log on to the end-user portal ( https://<SafeSync domain
name>) using the previously specified password.

ﬁ Note

A warning message may appear when you first visit the portal. Click Proceed.

For more information on updating the SSL certificate, see the SafeSync
Administrator's Guide.

2.  Logon to the SafeSync web console using the administrator account credentials:
. User name: administrator
. Password: <web console account password>

3.  Click Upload Files to upload files to SafeSync.

The Upload Files screen appears.

| @ Upload Files

File Name Size Status

© Addfiles || # Startupload Close 0b 0%

4. Sclect the files you want to upload and click Add Files.
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ﬁ Note

Select at least one photo to upload.

5.  Click Start Upload.

The files you select will be uploaded to SafeSync.

) TREND. SafeSync for Enterprise
AE

administrator (admistrator) - Sign out

£|| & pload Fies [ORTRINERSY Account information

@ Viewhis photo ame sz T @ view details

(3 Download this photo @ Backup Fie Foider 280772014 15:50 28 Seats used: 4 of 200
«& Getlinkto this photo [4 & T_sampe 212.20 KB JPEGAFIF image. 300712014 11:12

@ Previous versions

X Delete this photo TH_Sample

2 Renamethis photo
C» Move or copy this photo

i Personal Folders
£ Team Folsers.
1 Recyck Bin

View sign n istory
18 View events history
8 Downioass

© Gethelp

Note

The photos you upload to SafeSync, display as a thumbnail in the content area.

) IREND. SafeSync for Enterprise ——

) Viewimages and videos
[ Download this folder
o Create a newfolder

Show shared content B
= —

Bersonai Foiders

@ view dstas
C (3 Seats used: 401200

Backup TH_Sample

Team Folders
| Recycle 8in

View sign n istory
18 View events history
8 Downioass

© Gethelp

6.  Select the files that were just uploaded and click Download the selected items.

A dialog box appears.

7.  Specify where to download the selected files and click OK.

The selected files download to the location you specify.
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8.  Select a photo you uploaded and click View this photo.

The photo appears in its original size.

O SafeSync for Enterprise - TM Sample - Google Chrome

9.  Share your files by selecting a file and clicking Get link to this file.

SafeSync creates a shareable link to that file. Recipients of the link can access the
files by clicking the link.

Share this photo
SafeSync provides security for any fink y
y or all of the opti
cursor over an option to learn more ab:

Only the owner of a personal folder or users added to a team
folder are able to open the encrypted files.

Shareable link Hip/Koala jpg?a
Enable Extra Protection

Password
Link expires on

single-use link [

Lo ew [ sve ] oo
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Checking System Status

The System Status Alert widget displays information regarding the SafeSync system
status and any available details about errors that occut. There is a separate System

Status Alert widget for each installed server.

Note

The System Status Alert widget refreshes every 10 minutes.

The following table describes the information available on the widget:

TABLE 5-1. System Status Alert Widget

ITEM

DESCRIPTION

System Version

Displays a warning when the current SafeSync product version is
not working properly.

Disk Usage

Displays a warning when the disk space is insufficient.

Storage

Displays a warning when the storage and backup features are not
working properly.

System Service

Displays a warning when a system service is not working properly.

Database HA

Displays a warning when the database replication function is not
working properly.

Shared Protection
Extension

Displays a warning when the encryption function is not working
properly.

Procedure

1.

2.

. &: Normal

Log on to the SafeSync web console.
Go to Dashboard > System Status > System Status Alert.

Verify the status of the servers using the following icons.
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. @: Warning

Checking Services

You can run the following commands to check the status of SafeSync services.

Procedure

1.  Log on to the server shell.

2. Run the following command to assume root permission:
sudo -1i

3. Provide the system server password when prompted.

4.  Run the following commands:

a.  To check if important SafeSync services were installed:
root@appliancel:~# supervisorctl status

ﬁ’ Note

For the complete list of required services, see Services on page 7-3.

b.  To check if important SafeSync services are working propetly:
root@appliancel:~# supervisorctl status

The following services should be listed as RUNNING:
. healthcheck

+  mgmtui

. perlbal80

. perlbalmgmtui

. thin
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5. Run the following commands to check if individual services are running:

SERVICE COMMAND
apache2 rootQappliancel:~# /etc/init.d/apache2 status
avscand root@appliancel:~# /etc/init.d/avscand status
grunjobs root@appliancel:~# /etc/init.d/grunjobs status
kmsd root@appliancel:~# /etc/init.d/kmsd status
lighttpd root@appliancel:~# /etc/init.d/lighttpd status
memcached rootQappliancel:~# /etc/init.d/memcached status
mysq|l root@appliancel:~# /etc/init.d/mysql status
nginx root@appliancel:~# //etc/init.d/nginx status
tmsyslog root@appliancel:~# /etc/init.d/tmsyslog status

6. Run the following commands to check service processes:

SERVICE COMMAND
gearman-job- root@appliancel:~# ps aux | grep gearman-job-server
server
keepalived root@appliancel:~# ps aux | grep keepalived
mogilefsd root@appliancel:~# ps aux | grep mogilefsd
mogstored root@appliancel:~# ps aux | grep mogstored

Verifying MySQL HA

Verify the high availability deployment of your MySQL database.
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Procedure
1. On the Primary server, log on to the MySQL console and create database testl.
a. root@appliancel:~# mysgl -u root -p

b. At the resulting prompt, type the MySQL password.

Note

The default password is safesync.

root@localhost [ (none)]> create database testl;
C. Query OK, 1 row affected (0.00 sec)

2. On the Secondary server, log on to the MySQL console and verify that database
test] now exists there as well.

a. root@appliance2:~# mysgl -u root -p
b. At the resulting prompt, type the MySQL password.

C. root@localhost [ (none)]> show databases;

| information schema |
| auth |
| data \
| gearman |
| mogilefs |
| mysqgl

| osdp \
| shard 1 |
| testl \

9 rows in set (0.00 sec)
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3. After verifying, drop database testl:
a. root@localhost [ (none)]> drop database testl;

Query OK, 0 rows affected (0.00 sec)

Failover

SafeSync provides a failover if two servers are deployed. Administrators must correctly
deploy the servers and in some cases configure other areas of their network. For
example, there are two required criteria for SafeSync failover to work correctly:

1. The Primary and Secondary servers must be installed and running correctly.

2. The administrator must setup name services to provide for failover in DNS.

Note

Actual partitions and size may vary per server.

Internal Failover

The SafeSync failover mechanisms rely on keepalived and MySQL HA. The third-
party service keepalived uses the VRRP protocol to provide and manage a virtual IP.
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When the primary MySQL cannot provide service, the VIP fails over to the secondary
MySQL database.

NIC:frontend

SafeSync
Internal
DB client

NIC:database()
192.168.200.2
L]

' Keepalived :

L P R Y R T T

Verifying File Replication

Check the file replication status of your high availability deployment.

Procedure

1.  Upload a test file (test.txt) to SafeSync.

2.  Log on to the server shell.

3. Log on to MySQL using the following command.
root@appliancel:~# mysql -uroot -p shard 1

a.  Type the password when prompted.

Note
The default password is “safesync”.

4.  Get the file data_id from the database.
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root@localhost [shard 1]> select data id from objects where

name="' test.txt ';

tom————— +
| data id |
+———— S
| 303 |
tom————— +

1 row in set (0.00 sec

5. Check that two file paths exist in the MogileF'S.

root@appliance2:~# mogtool --trackers=trackerl:6001 --

domain=osdp locate 303

http://192.168.200.2:7500/dev21/0/000/001/0000001145.fid
http://192.168.200.1:7500/dev13/0/000/001/0000001145.fid

#2 paths found

5-11







Post-Installation Tasks

This chapter outlines recommended and optional post-installation tasks for SafeSync.
Topics in this chapter include:
o Abont Adding MogileF'S Storage on page 6-2

Mounting Additional Disks on page 6-2

«  Adding a Network Device on page 6-4
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About Adding MogileFS Storage

When existing MogileFS partitions are used up, you can mount additional disks or
storage partitions into the server. You may choose to add local disks or external network
storage such as NFS, CIFS, or iSCSI.

SafeSync requires console command-line execution for adding storage devices. The
deployment environment of SafeSync contains one or two servers: primary and
secondary. The installation process detects all existing hard disks, formats the disks,
mounts the disks to file system, and then adds the disk to MogileF'S system. The file
system mount points for disk are /storage/mogdata/dev [primary: 1,
secondary: 2] [number].

For example, the first disk on primary server in MogileI'S system is mounted on /
storage/mogdata/devll and the first disk of secondary server is mounted on /
storage/mogdata/dev2l.

When creating new mount points for new MogileI'S storage, always follow this
sequence. In this case, the second disk on the primary server should be mounted to /
storage/mogdata/devl2, the third disk on /storage/mogdata/devl13.
Consequently, for the secondary server, the mount points will be /storage/
mogdata/dev22 and /storage/mogdata/dev23.

Reusing a mount point that was previously deleted is not allowed.

Mounting Additional Disks

SafeSync automatically mounts only one disk by default. Additional disks need to be
manually mounted to SafeSync.

The example below assumes that SafeSync is deployed as a set of paired appliances, and
the primary server already has one disk installed. This example describes how to add a
new disk to the primary server.

ﬁ Note

These steps are only required if you want to use more than one disk.
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Procedure
1. Log on to SafeSync.
2.  Obtain the root permission:
# sudo -i
3. Specify the root password.
4. Format the disk before mounting it to SafeSync:
This example uses sdb as the name of the new disk.
# dmesg | grep sdb
# parted -s /dev/sdb mklabel gpt
# parted -s /dev/sdb mkpart primary ext4 0% 100%
# partprobe /dev/sdb
5. Mount the disk:
# mkdir /storage/mogdata/devl12
# mkfs -t extd /dev/sdbl
# mount /dev/sdbl -t ext4 /storage/mogdata/devl2
6. Add the disk to the mogile system:
# chown www-data:mogstored /storage/mogdata/devl2
# chmod g+w /storage/mogdata/devl2

# mogadm --trackers=trackerl:6001 device add osdp-storel 12 --

status=alive

7.  Use the vim editor to change /etc/fstab to check that it contains the new disk
data.

# vim /etc/fstab

a. Addaline to /etc/fstab with the new disk data.

6-3
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/dev/sdbl /storage/mogdata/devl2 ext4
defaults,user xattr, netdev 1 2

8. Check the result.

# mogadm check

Adding a Network Device

A WARNING!

Trend Micro recommends using only network storage to expand SafeSync, because local,
externally-mounted storage devices have a high risk of data loss if they are unexpectedly
removed.

NFS (Client-side)

SafeSync supports the Netwotk File System (NFS), a client/server application.

Procedure

1. To install the NFS-common portmap, run the following command from a
command line editor.

# apt-get install nfs-common portmap
2.  Restart portmap.

# service portmap restart
3. Create a new mount point on the server.

# mkdir /storage/mogdata/devl3

4.  Mount a new device to the mount point.

# mount -t nfs <IP address>:/tmp /storage/mogdata/devl3
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ﬁ Note

/tmp is the directory name of the NFS mount path.

5. Check the result.
# showmount -e <IP address>

6. Change the owner of /storage/mogdata/dev13.
# chown www-data:mogstored /storage/mogdata/devl3

7.  Change the file mode of /storage/mogdata/dev13, giving it group authority to write.
# chmod g+w /storage/mogdata/devl3

8.  Use the vim editor to change the disk usage and free space shown by df. The
output should no longer include storage in the local file system.

a. # vim /usr/local/share/perl/5.10.1/Mogstored/ChildProcess/
DiskUsage.pm

b.  Go to line 58, which should contain the stringmy $rval = “df $gnu df
-1 -k $path/$devnum’;, and change the string tomy $rval = “df
$gnu_df -k Spath/S$devnum’;.

Q Tip

The parameter -1 has been removed, the string is otherwise unchanged.

c.  Save the file and close vim.
9. Add a mount point to MogileFS.

# mogadm --trackers=trackerl:6001 device add osdp-storel 13 --

status=alive
10. Restart mogstored.

# /etc/init.d/mogstored restart

11. Check the result.

6-5
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# mogadm check

Checking trackers...
trackerl:6001 ... OK

Checking hosts...
[ 1] osdp-storel ... OK

Checking devices...

host device size (G) used (G) free (G) use% ob state
[ 1] devll 7.027 5.590 1.437 79.55% writeable
[ 1] devl2 5472 0.018 7.454 0.24% writeable
[ 1] devl3 7 025, 5.510 1.517 78.41% writeable
total: 21526 11.118 10.408 52.73%

12. Use the NFS mount command at /etc/rclocal to auto-mount storage located on
NFS after the system reboots using the following command.

# mount -t nfs <IP address>:/tmp /storage/mogdata/devl3

Samba (Mount CIFS)

SafeSync supports the smbfs filesystem, a mountable SMB filesystem for Linux.

Procedure
1. To install SMBFS, run the following command from a command line editor.
# apt-get install smbfs

2.  Use the vim editor to change the disk usage and free space shown by df. The
output should no longer include storage in the local file system.

a. # vim /usr/local/share/perl/5.10.1/Mogstored/ChildProcess/
DiskUsage.pm

b.  Go to line 58, which should contain the stringmy $rval = “df $gnu df
-1 -k spath/$devnum’;, and change the string tomy $rval = “df
$gnu_df -k S$path/S$devnum’;.
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Q Tip

The parameter -1 has been removed, the string is otherwise unchanged.

c.  Save the file and close vim.
3. Change the permissions on the mogstored service.
a.  Edit the /etc/init.d/mogstored.
# vim /etc/init.d/mogstored

b.  Replace ~—chuid mogstored with ~—chuid www-data.

ﬁ’ Note

You must modify lines 41 and 61.

c.  Save the file and close vim.
4.  Create a new mount point on the server.
# mkdir /storage/mogdata/dev14
5. Find out the UID of www-data.
a. # vim /etc/passwd www-data uid gid
b.  Look for a line starting with www-data.

Text to the right of www-data will be something like :x:33:33:www—
data:var/www:/bin/false. The number in the middle of x:33:33 tells
us that, in this case, the UID of www-data is 33. The GID and other
information can be ignored.

6. Mount CIFS.

ﬁ Note

Give the appropriate network user name and password for XXXXX. Use the UID for
www-data you found above in place of 33.

6-7
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# mount -t cifs //<IP address>:/tmp /storage/mogdata/devl4 -o
"username=XXXXX, password=XXXXX,uid=33"

ﬁ Note

/tmp is the directory name of the NFS mount path.

7.  Use the vim editor to change /etc/fstab so it contains the CIFS data.
a. # vim /etc/fstab

b. Add aline to /etc/fstab with the CIFS data.

ﬁ Note

Give the appropriate network user name and password for XXXXX. Use the
UID for www-data you found above in place of 33.

//<IP address>:/tmp /storage/mogdata/dev/14 cifs
username=XXXXX, password=XXXXX,uid=33 0 0

8.  Add a mount point for the new server to MogileFS, and make its status alive.

# mogadm --trackers=trackerl:6001 device add osdp-storel 14 --

status=alive
9.  Check the results.

# mogadm check

iISCSI

SafeSync supports Internet Small Computer System Interface (iSCSI), an Internet
Protocol-based storage networking standard.

Procedure
1. To install Open-iSCSI, run the following command from a command line editor.

# apt-get install open-iscsi
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2. Use iscsiadm discovery tool to get the iSCSI target name.
# iscsiadm -m discovery -t st -p <IP address>

[£d96:7568:9882:c5:211:32ff:fe02:82b7]:3260,0 <target iSCI
Qualified Name (IQN)> <IP address>:3260,0 <target IQN>

3. Log on using the iSCSI target name.

# iscsiadm -m node --targetname <target IQN> --portal "<IP
address>:3260" --login

Logging in to [iface: default, target: <target IQN>,
portal: <IP address>, 3260]

Login to [iface: default, target: <target IQN>, portal: <IP
address>, 3260]: successful

4.  Check the iSCSI disk name.
# 1s -1 /dev/disk/by-path/ip-*
5. Add a new partition for the disk /dev/sdd (where sdd is an iSCSI disk).

# parted -s /dev/sdd mklabel gpt #
parted -s /dev/sdd mkpart primary ext4 0% 100% #
partprobe /dev/sdd

6. List the partition table for /dev/sdd (sdd is an iSCSI disk).
# mkfs.extd /dev/sddl
7.  Create a new mount point for the server.
# mkdir /storage/mogdata/devl3
8.  Change the owner of /storage/mogdata/dev13.
# chown www-data:mogstored /storage/mogdata/devl3
9. Change the file mode of /storage/mogdata/dev13.

# chmod g+w /storage/mogdata/devl3
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10.

11.

12.

13.

14.

Test the mount.
# mount /dev/sddl /storage/mogdata/devl3
Add a mount point to MogileFS.

# mogadm --trackers=trackerl:6001 device add osdp-storel 13 --

status=alive

Use the vim editor to change /etc/fstab so it contains the iSCSI data.
a. # vim /etc/fstab

b.  Add aline to /etc/fstab with the iSCSI data.

/dev/sddl /storage/mogdata/devl13 ext3

defaults,user xattr, netdev 1 2
Set iSCSI auto startup.

sudo iscsiadm -m node --targetname "<target IQN>" --portal
"<IP address>:3260" -o update -n node.conn[0].startup -v
automatic

Q Tip

The entire sudo command above should be typed as one line without line feeds.

Check the results.

# mogadm check




Chapter 7

Frequently Asked Questions (FAQs)

This chapter answers various Frequently Asked Questions.
Topics in this chapter include:
Apache Server on page 7-2

DN Settings on page 7-2

Services on page 7-3
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Apache Server

What should | do if the Apache server does not start after
installing SafeSync?

When the Apache server does not start after installation, the following error message
appears:

* Starting web server apache2[Fri Dec 14 20:56:06 2012] [error] Can't open /var/log/
osdp/osdp.log (Permission denied) at /ust/local/share/petl/5.10.1/Log/Log4petl/
Appendet/File.pm line 103.\nCompilation failed in require at /opt/TrendMicro/
OSDP/Lib/Storage/FotkControl.pm line 4 \nBEGIN failed--compilation aborted

at /opt/TrendMicro/OSDP/Lib/Storage/ForkControl.pm line 4.\nCompilation failed
in require at /opt/TrendMicro/ OSDP/Config/startup.pl line 4.\nBEGIN failed--
compilation aborted at /opt/TrendMicro/ OSDP/Config/startup.pl line

4 \nCompilation failed in requite at (eval 2) line 1.\n[Fti Dec 14 20:56:06 2012] [etroz]
Can't load Petl file: /opt/TrendMicro/OSDP/Config/startup.pl for server (null):0,
exiting......faill

This error occurs when the minimum system requitements are not met during
installation..

To resolve this issue, make sure your environment meets the minimum system
requirements. For more information, see Systenz Requirements on page 2-2.

DNS Settings

Why am | unable to connect to the Administrator
Console?

Creating proper DNS records is a critical part of SafeSync deployment. If these are not
created correctly, users will not be able to access SafeSync.
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For more information, see Reguired Network Settings on page 2-4

Services

What services should be installed after a successful
SafeSync installation?

The following services should be installed after a successful SafeSync installation:

apache2 mgmtui
avscand mogilefsd
gearman-job-server mogstored
grunjobs mysql
healthcheck nginx
keepalived perlbal80
kmsd perlbalmgmtui
lighttpd thin
memcached tmsyslog

How can | verify if all SafeSync services are working
properly?

Procedure
1. Log on to the server shell.

2. Run the following command to go to the specific directory:

cd /opt/SingleInstaller/nodeControl/bin/
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3. Run the following command to check the service status:
./check all service status.sh
If there are no problems, the command line editor displays the following message:

All SafeSync services are working properly




Chapter 8

Contacting Technical Support

This chapter describes how to use the Support Portal and contact Trend Micro.
Topics in this chapter include:

Contacting Trend Micro on page §-2

Speeding Up the Support Call on page 8-2
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Contacting Trend Micro

In the United States, Trend Micro representatives are available by phone, fax, or email:

Address Trend Micro, Inc. 10101 North De Anza Blvd., Cupertino, CA 95014

Phone Toll free: +1 (800) 228-5651 (sales)
Voice: +1 (408) 257-1500 (main)

Fax +1 (408) 257-2003
Website http://www.trendmicro.com
Email address support@trendmicro.com

+  Worldwide support offices:
http://www.trendmicro.com/us/about-us/contact/index.html
+  Trend Micro product documentation:

http://docs.trendmicro.com

Speeding Up the Support Call

To improve problem resolution, have the following information available:

. Activation code and license status
. Browser information and version
+  Product version and system update history

+  Steps to reproduce the problem

. Appliance or network information

. Computet/device brand, model, and any additional hardware connected to the
endpoint



http://www.trendmicro.com
mailto:support@trendmicro.com
http://www.trendmicro.com/us/about-us/contact/index.html
http://docs.trendmicro.com

Contacting Technical Support

Memory and disk or storage status
Computet/device operating system and setrvice pack version
Detailed description of the installation environment

Exact text or screenshot of any error message received
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